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Section 1: Overview
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This tutorial provides step-by-step guidance for the sample frame structure. Enough details are 

provided that the example model with non-doubly symmetric sections can be completed following 

the instructions here. Not every feature available in MASTAN2 will be mentioned nor utilized in this 

tutorial. For further information on several additional features within MASTAN2, it is recommended 

the user make use of other tutorials at http://www.mastan2.com/tutorial.html. 

Overview

http://www.mastan2.com/tutorial.html
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This tutorial will start with the simple one-bay frame shown on the left. This model will then be 

altered to the two-bay frame shown on the right include non-doubly symmetric sections. Further 

details of each model will be provided in the corresponding section.

Problem Overview

Starting Frame Final Frame
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Section 2: Getting Started
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MASTAN2 is an interactive graphics program that provides preprocessing, analysis, and postprocessing 

capabilities. Preprocessing options include definition of structural geometry, support conditions, applied loads, and 

element properties. The analysis routines provide the user the opportunity to perform first- or second-order elastic 

or inelastic analyses of two- or three-dimensional frames and trusses subjected to static and dynamic loads. 

Postprocessing capabilities include the interpretation of structural behavior through deformation and force 

diagrams, printed output, and facilities for plotting response curves. MASTAN2 is based on MATLAB®, a premier 

software package for numeric computing and data analysis. 

In many ways, MASTAN2 is similar to today’s commercially available software in functionality. The 

number of pre- and post-processing options, however, have been limited in order to minimize the amount of time 

needed for a user to become proficient at its use. The program’s linear and nonlinear analysis routines are based on 

the theoretical and numerical formulations presented in the text Matrix Structural Analysis, 2nd Edition, by McGuire, 

Gallagher, and Ziemian. In this regard, the reader is strongly encouraged to use this software as a tool for 

demonstration, reviewing examples, solving problems, and perhaps performing analysis and design studies. Where 

MASTAN2 has been written in modular format, the reader is also provided the opportunity to develop and 

implement additional or alternative analysis routines directly within the program. 

MATLAB is a registered trademark of The MathWorks, Inc., 3 Apple Hill Drive, Natick, MA 01760-2098.

MASTAN2 General Information
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Two versions of MASTAN2 have been developed and may be installed. One requires you to have 

access to MATLAB and the other does not. Both versions provide the same functionality, except that 

the MATLAB version also provides the user an opportunity to develop and implement additional or 

alternative analysis routines that will directly interact with MASTAN2. Please see the Setup Guides at 

www.mastan2.com.

Launching MASTAN2

Start Here

http://www.mastan2.com/
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In order to minimize the learning time for MASTAN2, its graphical user interface (GUI) has been 

designed using a simple and consistent two menu approach. Using a pull-down menu at the top of the 

GUI, a command is selected. Parameters are then defined in the bottom menu bar and the command is 

executed by using the Apply button.

Base Layout

Main model window

Bottom menu bar

Edit Field

Pull-down menu

Submenu

Button
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Section 3: 2-D Frame Analysis
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The frame is constructed of A992 steel with the properties indicated. The frame is also supported out 

of plane in the Z direction at the ends and middle of the beam. The connections are assumed to be 

fixed for warping.

MASTAN2 does not assume any unit system. Models in MASTAN2 require the use of any consistent 

set of units. This tutorial will use kip and inch.  

A few steps completed as part of this segment of the tutorial are not specifically required for a 2-D 

analysis. Comments are provided to identify them.

Problem Description - Figure

A992 Steel
E=29,000 ksi
fy=50 ksi
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1) Start with a new, empty model. 

2) From the Geometry menu select Define Frame.

3) At the bottom menu bar, click the pop-up menu to the left of bays @ and change 0 to 1. Click in the 

edit box to the right of bays @ and change 0 to 720.

4) Click the pop-up menu to the left of stories @ and change 0 to 1. Click in the edit box to the right of 

stories @ and change 0 to 360.

5) Click on the Apply Button. A one-bay single story frame is now defined.

Clicking the             icon will advance the tutorial to a page that provides an image of the MASTAN2 

interface after the corresponding step is executed. Clicking the          icon on that page will return you 

to the step-by-step instructions.

Geometry Definition
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Note: At first launch you should see MASTAN2 version 

information in bottom bar. This screenshot is from 

a new model after MASTAN2 was already open.
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1) From the Geometry menu select Subdivide Element(s).

2) Create the list of elements by clicking on the horizontal element.

3) Since the number of segments is already set at 2, click on the Apply button.

4) Create a new list of all elements by clicking the All button.

5) Click the > button to the right of # of Segments = to increase 2 to 8. 

6) Click on the Apply button.

Element Modification
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These steps are not technically required; however, it will help makes it easier to find results in the 

model. Additionally, any reference to node or element number will be using this updated reference.

1) From the Geometry menu select Renumber Elements.

2) Click the checkbox to the left of Y-X-Z (2D). Click on the Apply button.

3) From the Geometry menu select Renumber Nodes.

4) Click the checkbox to the left of Y-X-Z (2D). Click on the Apply button.

Model Cleanup
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1) From the Properties menu select Define Section.

2) At the bottom menu bar, click on the Database button. 

3) In the pop-up menu, scroll to find Section: W10x49 and click on it. 

4) Then click on the Apply button. Section 1 is now defined with the properties of W10x49. 

5) Repeat step 3 with Section: W27x84. After clicking the Apply button, Section 2 will be defined.

For the initial 2-D analysis, only Area, I z-z, and Z z-z would be required. The other section properties 

are only needed when moving to 3-D analysis.

Section Properties - Creating
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1) From the Properties menu select Attach Section.

2) At the bottom menu bar, use the buttons to the right of Element(s): to make the list of elements.

3) Click the Adv button to open pop-up menu. To select all the vertical elements, click the check box 

next to the Y-axis option. Click Add to add all vertical elements to the element list. 

4) Click on the Apply button to assign Section 1. (Note that the element line style has changed from 

dash-dot to dashed.)

5) Select the Clr button located to the right of Elements: to clear the list of elements. 

6) Create a list of the remaining elements by clicking the All button and then the Remove button in 

the pop-up menu. This should leave only the horizontal members selected.

7) Change the Section # by clicking on the current section number, 1, just to the right to open a pop-

up menu with all section numbers. Click on 2 to select the W27x84 section. 

8) Assign Section #2 properties by clicking the Apply button.

Section Properties - Assigning
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1) From the Properties menu select Define Material.

2) At the bottom menu bar, click in the edit box just to the right of E= and change the 0 to 29000 (not 

29,000). Similarly, click in the edit box just to the right of Fy= and change the inf to 50. Next, click in 

the edit box to the right of Name: and type A992. Click on the Apply button. (Material #1 is now 

defined with the properties of A992 steel.)

3) From the Properties menu select Attach Material.

4) At the bottom menu bar, create the list of elements to be assigned the properties of Material 1 by 

clicking on the All button to the right of Elements:. Click on the Apply button. (Note that elements 

with assigned section and material properties turn solid.)

Material Properties
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1) From the Conditions menu select Define Fixities.

2) At the bottom menu bar, define a fixed support by clicking in the check boxes just to the left of all 

six degrees of freedom: X-disp, Y-disp, Z-disp, X-rot, Y-rot, and Z-rot.

3) Create the list of nodes to be assigned these fixities by clicking on the bottom two nodes of the 

model, 1 and 25.

4) Click on the Apply button.

5) From the View menu select Fit.

For the initial 2-D analysis, only X-disp, Y-disp, and Z-rot would need to be constrained for full fixity. 

The other fixities are only needed when moving to 3-D analysis.

Support Conditions
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1) From the Conditions menu select Define Forces.

2) At the bottom menu bar, click in the edit box just to the right of PX = and change the 0 to 10.

3) Create the list of nodes to be assigned these forces by clicking on the upper left-hand node, 9.

4) Click on the Apply button.

5) From the Conditions menu select Define Uniform Loads. 

6) Since the loading input is already Element(s) local x’-y’-z’, click in the edit box just to the right of 

wy’ = and change 0 to -0.1.

7) Click the Adv button to open pop-up menu. Create a list of the horizontal elements by clicking the 

All button and then the Remove button in the pop-up menu.

8) Click on the Apply button.

9) From the View menu select Fit.

Loading
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These steps are technically optional as you can complete analysis without saving or applying a title; 

however, this is a good time to complete this.

1) From the File menu select Define title. At the bottom menu bar, click in the edit box to the right of 

Title: and type in a brief description of this effort. This text might include the model title, your 

name, and/or the assignment number. Click on the Apply button.

2) From the File menu select Save As … . After selecting your destination folder, type in the filename 

Frame and click Save. Note that the top of the window has now changed to include the file name 

and directory as well as the time the file was last saved.

Naming and Saving
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1) From the Analysis menu select Static and submenu option 1st-Order Elastic.

2) At the bottom menu bar, click on the pop-up menu just to the right of Analysis Type: and Select 

Planar Frame (x-y).

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, click on the Apply button.

6) From the Results menu select Node Displacements.

7) On the undeflected shape, click on the node of interest in the upper right corner, 33, and its 

components are provided in the bottom menu bar. 

Results:

This can be repeated for other nodes by clicking on them or click in the edit box to the right of Node:, 

enter the value, and click Apply.

2-D First-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

2.688 -0.03312 N/A N/A N/A 0.01235
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, click on the pop-up menu just to the right of Analysis Type: and Select 

Planar Frame (x-y).

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) On the undeflected shape, click on the node of interest in the upper right corner, 33, and its 

components are provided in the bottom menu bar. 

Results:

2-D Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

2.852 -0.05354 N/A N/A N/A 0.01243
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Section 4: 3-D Frame Analysis
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As is, the model could be run in 3-D. Previously having entered the complete section properties and 

applying full fixity to the base support nodes would be satisfactory to meet the requirements to run a 

3-D analysis. However, this model would be missing the lateral support of the beam previously 

mentioned in the problem statement. Before proceeding, we will add that support to the frame 

through additional boundary conditions.

1) From the Conditions menu select Define Fixities.

2) At the bottom menu bar, define the lateral support by clicking in the check box to the left of Z-disp. 

3) Create the list of nodes to be assigned these fixities by clicking on the top corner and middle nodes 

of the model: 9, 17, and 33.

4) Click on the Apply button.

5) From the View menu select Defined Views and submenu option Isometric: x-y-z.

Updating for 3-D Analysis
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, click on the pop-up menu just to the right of Analysis Type: and Select 

Space Frame.

3) Click on the Apply button to perform the analysis. 

The analysis should stop with the message Analysis Halted: Limit Reached. Often this message is 

related to the analysis encountering a stability limit. The use of the eigen-buckling tool may help 

identify the problem.

3-D Second-Order Elastic Analysis
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1) From the Analysis menu select Eigen-Buckling and submenu option Elastic Critical Load.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame with the Max. # 

of Modes: set to 1 as desired.

3) Click on the Apply button to perform the analysis.

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, click the edit box to the right of Scale. Change 10 to 30 to amplify the 

deformed geometry in the visualization.

6) Click on the Apply button and the first mode is shown with the Applied Load Ratio identified at the 

top of the screen.

The result indicates that the beam is failing in lateral torsional buckling at only 0.687 times the 

applied load. Currently, the analysis does not include the warping stiffness which increases the 

buckling capacity of the beam. MASTAN2 can account for warping effects if the element’s warping 

end conditions are changed.

3-D Elastic Critical Load
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1) From the Geometry menu select Define Connections and submenu option Torsion.

2) At the bottom menu bar, click on the menu to the right of Warping Restraint for Node i and set the 

value to Continuous. Repeat this for the Warping Restraint for Node j. 

3) Create the list of elements to be assigned continuous warping by clicking on the All button to the 

right of Elements:. Click on the Apply button. Note: no symbol indicates the end is free to warp, a 

blue + indicates continuous warping, and a blue ✳ indicates fixed warping.

4) Click Clr to empty the list of elements. Click on the bottom element of each column and left end 

element of the beam to define the members that start with warping fixed and are continuous.

5) Click on the menu to the right of Warping Restraint for Node i and set the value to Fixed. Node j is 

set from the previous step. Click on the Apply button. 

6) Click Clr to empty the list of elements. Click on the top element of each column and right end 

element of the beam.

7) Click on the menu to the right of Warping Restraint for Node i and set the value to Continuous. 

Click on the menu to the right of Warping Restraint for Node j and set the value to Fixed.

8) Click on the Apply button. 

Adding Warping Effects
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1) From the Analysis menu select Eigen-Buckling and submenu option Elastic Critical Load.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame with the Max. # 

of Modes: set to 1 as desired.

3) Click on the Apply button to perform the analysis.

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, the Scale should still be set to 30 from previous analysis. 

6) Click on the Apply button and the first mode is shown with the Applied Load Ratio identified at the 

top of the screen.

The result indicates that the beam is failing in lateral torsional buckling at 1.31 times the applied load. 

This value is 1.9 times the result when ignoring the effects of warping stiffness. The fact that the 

Applied Load Ratio is greater than 1 means it should now be possible to complete the desired 3-D 2nd

order analysis.

3-D Elastic Critical Load
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) On the undeflected shape, click on the node of interest in the upper right corner, 33, and its 

components are provided in the bottom menu bar. 

Results:

The deflection response is the same as 2-D as no out-of-plane loading or displacements were added. 

The same axial and flexural deformations are being modeled. The introduction of the 3-D analysis 

highlighted the existing out-of-plane instability and the analysis could not proceed past the 

bifurcation load in the perfect model. 

3-D Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

2.852 -0.05354 0 0 0 0.01243
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Section 5: Using MSASect
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The section properties used so far have been for doubly symmetric cross sections where we would 

have looked up the values or calculated them outside the program for ourselves. The updated version 

of MASTAN2 includes a new tool MSASect that can calculate section properties for thin wall cross 

sections. MSASect can be used with open and closed cross sections whether symmetric or not. In 

addition to the section properties used thus far, MSASect will calculate the necessary non-doubly 

symmetric section properties. The tool is found within the Define Section and Modify Section menu. 

As a demonstration, the section properties of a W27x84 cross section will be found.

MSASect
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The W27x84 cross section is shown below. Figure A illustrates the full cross section with fillets that is 

associated with the AISC table values. Figure B illustrates the simplified section with overlap and no 

fillets that represents the cross section to be calculated by MSASect. These are the dimensions to be 

entered when working with the template. Figure C illustrates the resulting node to node model 

created when using the template that will be used for calculations in MSASect.

Cross Section Geometry
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1) From the Properties menu select Define Section.

2) At the bottom menu bar, click on the pop-up menu on the far right that currently displays Basic. 

Click on Advanced and new edit boxes and buttons should appear.

3) Click on MSASect.

4) As the I-beam cross-section is selected by default, click the edit box to the right of B1= and enter 

10. Repeat to define B2=10, D=26.7, t1=0.64, t2=0.64, and t3=0.46. 

Note: The dimensions to enter in the template correspond to Figure B on the previous page. While the section 

property calculations need to be completed using the dimensions shown in Figure C, this information is 

automatically generated based on the assumption that the numbers provided followed Figure B. 

5) Click Calculate to determine the properties.

6) Click edit box to right of Name: and enter W27x84Hand.

7) Click Export to MASTAN2 to copy values to main program. 

8) Click Close to return to the main window. There will often be a confirmation when closing it.

9) Click Apply to define Section 3.

Using MSA Sect
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1) From the Properties menu select Information and submenu option Section.

2) Change the Section # by clicking on the current section number just to the right to open a pop-up 

menu with all section numbers. Click on 2 to view the Section Properties based on the AISC 

database. Repeat with clicking on 3 to see the MSASect calculated values. 

From the comparison of section properties from AISC and the values calculated by MSASect, most of 

the calculated properties match well. Take note that some of the template shapes calculate standard 

shear area values. To match the previous analysis, the A v-v and A w-w would need to be set to inf.

MSASect Results

Property Units AISC MSASect Difference

A in2 24.7 24.79 0.4 %

Izz in4 2850 2852 0.1 %

Iyy in4 106 106.9 0.8 %

J in4 2.81 2.59 -7.7 %

Cw in6 18000 18110 0.6 %

Zzz in3 244 244.9 0.4 %

Zyy in3 33.2 32 -3.6 %
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If one of the default cross sections does not cover your situation the General option allows for the 

input of nodes and line segments by the user. Clicking the radio button next to General and then the 

Next button will open an interface that allows for the input of nodes and line segments directly. If you 

want to verify the final node coordinates used or tweak a default geometry, click Convert to General 

to gain access to the list of nodes and line segments automatically created in the MSASect interface. 

The following is an example of what the W24x87 would look like. Note that the coordinates 

correspond with Figure C shown previously.

Using MSA Sect
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The frame is constructed of A992 steel with the properties indicated. The frame is also supported out 

of plane in the Z direction on the beam at the column locations. The outer columns and top beam are 

assumed to be fixed for warping at the end. The beam is also continuous for warping over the middle 

column. The middle column is assumed to be free to warp at each end. 

Problem Description - Figure

A992 Steel
E=29,000 ksi
fy=50 ksi
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1) From the Geometry menu select Define Node.

2) At the bottom menu bar, click in the edit box to the right of x = and enter 360. Click in the edit box 

to the right of y = and enter 0. Click in the edit box to the right of z = and enter 0.

3) Click on the Apply Button.

4) From the Geometry menu select Define Element.

5) On the model, click the newly created node to define Node i. Then click the middle node of the top 

beam to define Node j. These nodes should be 34 and 17, respectively.

6) Click on the Apply Button.

Adding Interior Column
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1) From the Properties menu select Attach Material.

2) Create the list of elements to be assigned the properties of Material 1 by clicking on the new 

column. Click on the Apply button. (Note that elements with assigned just material properties turn 

dotted.)

3) From the Properties menu select Define Section.

4) At the bottom menu bar, click on the Database button. 

5) In the pop-up menu, scroll to find section W8x35 and click on it. Then click on the Apply button. 

(Section 4 is now defined with the properties of W8x35.) 

6) From the Properties menu select Attach Section.

7) Create the list of elements to be assigned the properties of Section 4 by clicking on the new 

column, element 33. 

8) Change the Section # by clicking on the current section number just to the right to open a pop-up 

menu with all section numbers. Click on 4 to select Section #4, W8x35. 

9) Assign Section 4 properties by clicking the Apply button.

Applying Material and Section Properties
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1) From the Geometry menu select Subdivide Element(s).

2) Create the list of elements by clicking on the new column.

3) Click the > box to the right of # of Segments = to increase 2 to 8. 

4) Click on the Apply button. (Note that same the section and material property information is given 

to all new elements.)

5) From the Conditions menu select Define Fixities.

6) At the bottom menu bar, define a pin support by clicking in the check boxes just to the left of X-

disp, Y-disp, and Z-disp.

7) Create the list of nodes to be assigned this fixity by clicking on the middle bottom node, 34.

8) Click on the Apply button.

Element Modification
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1) From the Geometry menu select Define Connections and submenu option Torsion.

2) At the bottom menu bar, click on the menu to the right of Warping Restraint for Node i and set the 

value to Continuous. Repeat this for the Warping Restraint for Node j. 

3) Use the buttons to the right of Element(s): to make the list of elements. Click the Adv button to 

open the pop-up menu. To select all the middle column elements, click the Off button to the right of 

Range (Inclusive) to turn this tool On. Click the edit box to the left of X and change –Inf to 359. 

Click the edit box to the right of X and change Inf to 361.

4) Click Add to add all these elements to the element list. Click on the Apply button to assign 

continuous warping.

Warping Continuity
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1) Click Adv to close the pop-up menu.

2) Click Clr to empty the list of elements. Click on the bottom element of the middle column to define 

the member that start with warping free and is continuous.

3) Click on the menu to the right of Warping Restraint for Node i and set the value to Free. Node j is 

set from the previous step. 

4) Click on the Apply button. 

5) Click Clr to empty the list of elements. Click on the top element of the middle column.

6) Click on the menu to the right of Warping Restraint for Node i and set the value to Continuous. 

Click on the menu to the right of Warping Restraint for Node j and set the value to Free.

7) Click on the Apply button.

Warping Boundary Conditions
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1) From the Geometry menu select Define Connections and submenu option Flexure.

2) At the bottom menu bar, click on the menu to the right of Type for Node j and set the value to 

Pinned. 

3) Create the list of elements by clicking on the top element of the middle column. 

4) Click on the Apply button to apply the pin connection. Note the orange circle is displayed to signify 

the end that has the Mx and My moment released. Torsion cannot be released. 

End Moment Release
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1) From the Properties menu select Modify Section.

2) At the bottom menu bar, Section #1 should be selected already. Click on the pop-up menu on the 

far right that current displays Basic. Click on Advanced.

3) Click on MSASect.

4) As the I-beam cross-section is selected by default, click the edit box to the right of B1= and enter 

10. Repeat to define B2=6, D=13, t1=0.625, t2=0.375, and t3=0.3125. 

5) Click Calculate to determine the properties.

6) Click edit box to right of Name: and enter Mono I

7) Click Export to MASTAN2 to copy values to main program. Then click Close to return.  

8) Click Apply to modify Section 1.

Modifying Section Properties
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1) Since the section was modified, the exterior columns are already assigned the appropriate section. 

The orientation just needs to be verified.

2) From the Geometry menu select Re-orient Element(s).

3) From the View menu select Labels and submenu option Element local x’-y’-z’ axes. Each axis is 

shown with a different color line drawn in the positive direction. The x axis is purple, the y axis is 

blue, and the z axis is red. 

4) At the bottom menu bar, click in the edit box to the right of Beta (Deg) and change 0.0 to 180. 

5) Use the buttons to the right of Element(s): to make the list of elements. Click the Adv button to 

open the pop-up menu. To select all the right column elements, click the edit box to the left of X and 

change 359 to 400. Click the edit box to the right of X and change 361 to 800.

6) Click Add to add all these elements to the element list. Click on the Apply button to re-orient the 

elements.

Column Orientation
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) On the undeflected shape, click on the node of interest in the upper right corner, 33, and its 

components are provided in the bottom menu bar. 

Results:

3-D Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

2.395 -0.02608 0 ~0 ~0 -1.304e-4
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This final frame could also have been modeled with MASTAN2 using only the symmetric section 

properties. Since the frame was loaded only in plane and the non-doubly symmetric effects were not 

activated, the user would find that it is possible to recreate the frame without the use of advanced 

section properties and only input the basic section properties and calculate similar displacements.

However, the evaluation of the critical buckling loads of the structure does capture the non-doubly 

symmetric effects. Different behavior could be observed if the user were to compare such an analysis 

on the frame with basic and advanced section properties. The first mode and second mode are very 

similar as the buckling behavior is controlled by the doubly symmetric elements. The third mode 

displays distinctly different behavior as the column is weaker considering singly symmetric behavior. 

Additional Analysis

Disp X Disp Y Rot Z

Basic 2.395 -0.02608 -1.304e-4

Advanced 2.395 -0.02608 -1.304e-4

Mode #1 Mode #2 Mode #3

Basic 2.160 2.806 4.936

Advanced 2.160 2.805 4.040
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This completes the tutorial.


